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RT_Image v0.2β User’s Guide 
 
RT_Image is a three-dimensional image display and analysis suite developed in IDL (ITT, Boulder, CO).  It offers a range of flexible 
tools for the visualization and quantitation of DICOM datasets encompassing a variety of medical imaging modalities. 
 
Compatibility 
Operating system: Windows 98, 2000, Me, XP 
Processor: Pentium 1 GHz or faster 
RAM: 128 MB free (larger amounts, up to 2 GB, are preferable when dealing with large datasets) 
Software: IDL version 6.0 or later  
 
Features 
 
Image format: DICOM 
 
Image display: 

• Multi-plane viewing 
• Oblique slicing/projection 
• Interactive window/levelling 
• Lookup table manipulation 

 
Image processing: 

• Fusion 
• Filter 

o Average 
o Median 
o Sobel 
o Gaussian 
o Difference of Gaussians 
o Add noise 

• Mask 
• Registration 
• Resample 

 
ROI analysis: 

• Definition 
o Rectangular 
o Elliptical 
o Freehand 
o Intensity contour 
o Region grow 
o Gradient find 
o Grouping into composite ROIs 
o Split into component ROIs 
o Input from ROI files 
o Import from DICOM RT structure sets 

• Manipulation 
o Placement 
o Edit points 

 Vertex edit 
 Resample 
 Smooth 
 Adjust vertices according to image 
 Morphologic operators 

o Edit geometry 
• Analyze pixel statistics 
• Export to existing DICOM RT structure set 
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Menus 
• File 

The file menu controls the reading of image data. 

 

• Open…: Shows the user the DCM image browser, in 
which one or more DICOM image series may be 
selected for loading. (p. 9) 

• Close: Closes the currently selected image dataset. 
• Close multiple: Allows the user to select multiple 

image datasets to close. 
• Quit: Ends the current RT_Image session.  All 

unsaved data will be lost. 
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• Edit 
The edit menu allows the user to undo the last action and the cutting, copying, and pasting of defined ROIs. 

 

• Undo: Returns the program to its state prior to the last 
action.  Note that undo does not work sequentially, ie 
the user cannot step backwards through multiple 
actions. 

• Cut: Deletes the currently selected ROI or ROIs and 
saves them to the clipboard for subsequent pasting. 

• Copy: Copies the currently selected ROI or ROIs to 
the clipboard for subsequent pasting. 

• Paste: Places a copy of the ROI or ROIs on the 
clipboard on the currently selected image.  The 
orientation (surface normal and axes) and center 
location of the ROI is adjusted to match that of the 
currently viewed image slice. 
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• View 
The view menu controls aspects of the image display. 

 

• Define…: Opens the set view window, allowing 
specification of the current view transformation.  
(p. 10) 

• Options: Opens the view options window, allowing 
specification of several aspects of the image display. 
(p. 11) 
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• Image 
The image menu contains the image-associated controls. 

 
 

Page Break
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• ROI 
The ROI menu controls the reading of ROI data. 

 

• Open…: Allows the user to select one or more ROI 
files to load.  The ROI format is specific to 
RT_Image. (p. 18) 

• Import…: Shows the user the DCM RT browser, in 
which contours from a DICOM RT structure set file 
may be selected for loading. (p. 18) 
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• Help 
The help menu contains basic program information. 

 

●   About RT_Image…:  
    Displays the program  
    information window,  
    containing program version  
    and compilation date. 
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Controls 

 
 
• Tools: The available and currently selected tools for use are displayed below the menu bar. 

  Select: Selects ROIs and adjusts crosshair. (p. 10) 
  Zoom: Zooms the view in and out. (p. 12) 
  Pan: Translates the current view. 
  Freehand: Define freehand ROIs. (p. 16) 
  Ellipse: Define elliptical ROIs. (p. 16) 
  Rectangle: Define rectangular ROIs. (p. 16) 
  Intensity contour: Define ROIs by intensity contouring. (p. 16) 
  Region grow: Define ROIs by region growing. (p. 17) 
  Gradient finding: Define ROIs by a combination of region growing and gradient finding. (p. 17) 

• Cursor information: The area underneath the toolbar displays the current location of the cursor as well as the image intensity at 
that point. 

• Image selection droplist: The droplist immediately above the image window selects the currently active image dataset.  Images are 
listed by patient name, modality, and date. 

• Slice sliders: The sliders below each image window control the slice location shown in that window.
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Images 
• Opening an image: Image data can be loaded by clicking Open… under the File menu. 

 

• Directory contents list: This list displays 
the contents of the currently selected 
directory.  When a directory is opened, 
it is scanned for usable DICOM files.  
This may take up to several minutes for 
directories containing many (1000+) 
DICOM files.  The results of this scan 
are archived so that subsequent accesses 
of the directory will not require a full 
re-scan. 

• Patient, date, study, and series lists: 
Once a directory is scanned for DICOM 
files, the data present is compiled by 
patient, date, study, and series.  This 
information is presented in these lists.  
The lists are hierarchical: selecting a 
patient will show the dates, studies, and 
series available for that patient, then 
selecting a date will show the studies 
and series for that date, and so on. 

• Load button: To load data, select the 
desired one or more SERIES from the 
series list and click load.  Note: 
selecting files from the directory 
contents list and clicking load will NOT 
open data.  

• Preview window: The preview window 
displays the contents of the selected file. 

• Show DCM contents button: To view 
the DICOM tags contained in a given 
file, select the file from the directory 
contents list and click the Show DCM 
contents button.  The window at bottom 
will then be displayed, showing a list of 
the tags present in the DICOM file 
sorted by group and element number.  
The list can be restricted to specific 
group and/or element numbers by filling 
in the appropriate fields at the bottom of 
the window. 
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• Viewing an image: Image data can be loaded by clicking Open… under the File menu. 

 
 

 

• Image windows: The image display windows are color 
coded.  The red and yellow windows at right always 
show coronal and sagittal views of the currently 
selected dataset.  The view of the primary green 
window may be adjusted using the define view 
window under the View menu. 

• Crosshairs: The crosshairs shown on each image are 
color coded to match the image windows, showing the 
orientation of the slice shown in the other two 
windows.  The select tool may be used to grab the 
crosshair in any window and adjust its location.  Upon 
releasing the left mouse button after dragging the 
crosshair, the other two windows will be updated with 
the corresponding image slice through the new 
crosshair location. 

 
Set view window 
• Center and rotation sliders: These controls specify the 

physical center location and rotation of the image 
plane shown in the primary, green image window.  
Any arbitrary oblique view may be specified by 
adjusting these sliders. 

• View droplist: Preset axial, coronal, and sagittal views 
may be selected for the primary window using this 
droplist. 

• Snap to image button: The view of the primary 
window may be fixed to match that of a loaded image 
dataset by clicking this button and selecting the 
desired image. 

• Type droplist: The type of image shown in the primary 
window is selected using this control.  The choices 
are: 
o Slice: A section is taken from the selected image 

dataset. 
o MIP: A maximum intensity projection at the 

specified direction (according to the rotation 
sliders) is displayed. 

o Surface rendering: The surface corresponding to 
the current display intensity minimum is rendered 
according to the current view transformation. 

o Volume rendering:  A volume projection of the 
current image is rendered.  With this option 
selected, the Set RGBO button becomes available 
to specify the rendering color and opacity lookup 
tables. 

• Sampling droplist: When the selected type is Slice, the 
selection of the sampling droplist determines the type 
of interpolation used to generate the displayed image.  
The choices are nearest neighbor (no interpolation), 
and trilinear interpolation. 

• Resolution fields: These values specify the physical 
spatial resolution of the currently displayed image.  
Zooming in and out will adjust these values 
accordingly.  The resolution of the view may be fixed 
to that of a loaded image by clicking the Image… 
button and selecting the desired image. 
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• Changing view options: Options for the current view can be accessed by selecting Options from the View menu. 

 

• Display orthogonal views button: This option allows 
the user to show or remove the coronal and sagittal 
secondary view windows from the program window. 

• Display crosshairs: This option allows the user to 
enable or disable display of the crosshair in each of the 
three image windows. 

 
• Viewing a fused image: When two or more images are open, the user may view an fusion of two images by selecting Fusion 

from the Image selection droplist. 

 
 

 

• Base image droplist: This control selects the image 
dataset to be used as the underlying foundation for the 
fusion. 

• Overlay image droplist: This control selects the image 
to be superimposed on top of the base image. 

• Transparent, Opaque buttons: These select whether the 
overlay image is superimposed on the base image in 
an opaque (overlay colors completely obscure the base 
image) or transparent (one can partially see the base 
image through the overlay) manner. 

• Transparency slider: The value selected in this control 
determines the transparency of the overlay when the 
Transparent option is selected. 

• Colormap droplist: The colormap used for the overlay 
image is selected using this droplist. 

• Reverse button: Allows the user to reverse the order of 
the selected colormap. 

• No. colors field: Specifies the number of colors to be 
used in the selected colormap. 
 

• Adjust Min/Max window: When viewing a fused 
image, the Adjust Min/Max window has an extra 
option specifying whether the display range of the 
base or overlay is being adjusted. 
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• Magnifying an image: The zoom tool may be used to zoom any of the three image windows in and out.  Left clicking in a 
window with the zoom tool selected will cause the magnification of that window to increase by a factor of 2.  Left clicking while 
holding down the ALT key will cause the magnification of the window the decrease by a factor of 2.  Every 
magnification/demagnification event shifts the center and crosshair location of each window to the location where the user 
clicked. 

 
• Setting an image’s color table: The lookup table of the currently selected image can be specified and manipulated by selecting 

Adjust→Color table from the Image menu. 

 

• Apply to all button: When this option is selected, changes to display settings made in 
the Set colortable window will be applied to all open images. 

• Image intensity mapping curve: The curve underneath the colortable displays 
graphically how colors in the color table are assigned to image intensity values 
between the display minimum and maximum.  Adjustment points (red boxes) allow 
the user to modify this curve.  Left clicking and dragging an adjustment point will 
shift the shape of the curve.  Right clicking on the curve will create a new adjustment 
point. 

• Reset Adjustment button: Clicking this button returns the image intensity mapping 
curve to a straight line. 

• Reset Points button: Clicking this button returns the adjustment points of the image 
intensity mapping curve to the initial three at 0, 0.5, and 1. 

• Color table droplist: The list at bottom selects the color table of the current image.  A 
variety of predefined color tables are provided.  A color table consists of a 256 
element list of colors.  When an image is displayed, it is first scaled so that values 
below or equal to the image display minimum setting become 0, values above or 
equal to the image display minimum setting become 255, and values in between are 
scaled linearly or logarithmically into integer values.  After scaling, the pixel’s 
intensity (0 to 255) is used to “look up” a color in the table, which is used for that 
pixel.  This scaling is for display only, and does not affect the actual pixel intensities 
or internal representation in the image. 

• Reverse button: Selecting this option will reverse the direction of the currently 
selected color table. 

 
• Setting an image’s display range: The display range of the currently selected image, which specifies the upper and lower image 

intensities on the currently selected color table, can be adjusted by selecting Adjust→Min/Max… from the Image menu. 

 

• Apply to all button: When this option is selected, changes to display settings made in 
the Adjust Min/Max window will be applied to all open images. 

• Minimum/Maximum, Window/Level droplist: The droplist immediately to the left of 
the Apply to all button selects whether the image display range is specified by the 
minimum (black) and maximum (white) image intensities, or by the image window 
(maximum-minimum) and image level (center intensity). 

• Linear, Logarithmic droplist: The droplist to the left of the Minimum/Maximum, 
Window/Level droplist selects the type of mapping used to display image intensities. 

• Scale to buttons: These buttons allow specification of an image’s display parameters 
relative to its pixel intensities. Scale to Image min/max sets the display minimum and 
maximum to the minimum and maximum intensities of the image.  Scale to 5%/95% 
sets the display minimum and maximum to the 5th and 95th percentiles of the image’s 
histogram. If the apply to all button is checked, the display parameters of all images 
are set to their minimum/maximum or 5th and 95th percentile. 

• Minimum/Maximum, Window/Level sliders: The sliders at the bottom of the window 
specify explicit values for the image display parameters. 
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• Filtering an image: The currently selected image may be filtered using one of several operators by selecting Filter… under the 
Image menu. 

 

• Type droplist: The type of filter to be applied to the currently selected image is 
selected using this control.  The available options are: 
o Average: A boxcar smoothing filter of the specified physical width. 
o Median: A median filter of the specified dimensions. 
o Sobel: The Sobel gradient approximation of an image. 
o Gaussian: Convolution with a Gaussian of the specified dimensions and physical 

size. 
o Difference of Gaussians: Convolution with the difference of two Gaussians of the 

specified dimensions and physical sizes. 
o Add noise: Adds noise of the specified type and parameters to the image. 

 
• Masking an image: Regions of the currently selected image may be set to a constant fixed value by selecting Mask… under the 

Image menu. 

 

• Mask droplist: This control selects the ROI to be used as a basis for masking the 
image. 

• Inside mask options: The user can specify how image regions inside the ROI will be 
processed using these controls.  Options under the droplist are Image (the image 
inside the ROI will be unaffected) or Value (the image regions inside the ROI will be 
replaced by a fixed value).  When Value is selected, the field underneath the droplist 
allow specification of the inside value to be used. 

• Outside mask options: Using these controls, the user can specify how image regions 
outside the ROI will be processed in a manner analogous to that described above. 

 
• Resampling an image: The currently selected image may be resampled to new dimensions by selecting Resample… under the 

Image menu. 

 

• Sampling buttons: This group of buttons selects the type of interpolation to be used 
when resampling the image. 

• Current dimensions fields: The dimensions of the currently selected image are shown 
here for reference. 

• New dimensions fields: The user can enter new dimensions for the currently selected 
image in these fields.  Upon clicking apply, the image will be resampled using the 
specified interpolation type to have the entered dimensions. 
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• Registering two images: Images may be brought into geometric alignment using a rigid body transformation by selecting 
Register… under the Image menu. 

 
 

 
 

• Image display windows: When in registration mode, the main window expands so that the primary image window consists of 
the reference image for registration on the left, and the subject image for registration on the right.  The coronal and sagittal 
windows display the corresponding views of the reference image for localization. 

 
Register images window 
• Reference and Subject droplists: The user can select the images to serve as the reference for registration and the subject for 

registration using these controls. 
• Transformation sliders: The user can specify a rigid body registration transformation to be applied to the subject image using 

these controls.  The transformation consists of a translation and a rotation along the RL, AP, and SI axes, centered at the 
specified reference point. 

• Load, Save alignment buttons: The current alignment transformation can be saved to a ALN file, specific to RT_Image, by 
clicking the Save alignment button and selecting an output file.  ALN files may subsequently be used to load a registration 
transformation by clicking the Load alignment button and selecting the desired file.  Note that registration transformations 
created between two image datasets can be applied to any two image datasets using this mechanism. 
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• Checkerboard options: The subject image display can be manipulated to consist of alternating patches of the reference and 
subject images by selecting this option.  This view can be helpful for determining the goodness of registration between two 
images.  The resolution of the checkerboard can be specified through the number of checks along the X and Y axes. 

• Marker options: Registration markers can be defined and used for semi-automatic registration. 
o Define markers button: When this option is selected, the select tool can be used to create marker pairs by left clicking in 

the primary image window.  Left clicking in a region without markers will create a new, synchronized pair of markers in 
the reference and subject images.  Left clicking and dragging a marker will shift its location. 

o Point droplist: The user can select a specific marker pair using this droplist, and subsequently edit its properties using the 
controls described below. 

o Marker display options: The color, symbol, and size of a given marker pair can be specified. 
o Reference and subject location fields: The location of the marker in the reference and subject images is provided by these 

fields.  The user can manually enter values in these boxes to explicitly set the location of each marker. 
o Shift slice, marker buttons: The buttons below the location fields allow rapid manipulation of the marker and image 

locations. 
  The left button moves the location of the selected marker to the currently viewed image slice. 
  The right button moves the location of the currently viewed image slice to that of the selected marker. 

o Synchronize button: When active, the currently selected marker pair will move in unison in the reference and subject 
images. 

o Load, Save points buttons: The current array of registration markers can be saved to a PTS file, specific to RT_Image, by 
clicking the Save points button and selecting an output file.  PTS files may subsequently be loaded by clicking the Load 
points button and selecting the desired file.  Note that registration points created for two image datasets can be loaded for 
any two image datasets using this mechanism. 

o Match points button: Once at least four registration marker pairs have been defined, they may be used to compute a 
registration transformation between two images by clicking the Match points button.  For best results, 5-10 registration 
marker pairs should be defined, and should not all be coplanar.  In other words, the registration points should be well-
spaced across the entire image dataset. 

• Metrics options: Several quantitative measures of registration can be computed. 
o Cross correlation button: Computes the cross correlation between the reference and subject image slices currently being 

viewed. 
o Mutual information button: Computes the normalized mutual information between reference and subject image slices 

currently being viewed. 
• Apply button: Applies the specified registration transformation to the subject image and closes the registration interface. 
• Cancel button: Returns the subject image to its original orientation and closes the registration interface. 
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ROIs 
• Defining ROIs 

 

All ROI definition should be performed in the primary, 
green image window. 
 
• Rectangle: When the rectangle tool is selected, left 

clicking and dragging will draw a rectangular ROI.  
When finished drawing the rectangle, release the left 
button to create the ROI.  Holding SHIFT while 
dragging out a rectangular ROI will force the shape to 
be square. 

• Ellipse: When the ellipse tool is selected, left clicking 
and dragging will draw a elliptical ROI.  When 
finished drawing the ellipse, release the left button to 
create the ROI.  Holding SHIFT while dragging out a 
elliptical ROI will force the shape to be circular. 

• Freehand: When the freehand tool is selected, left 
clicking will define a single vertex of the ROI.  
Subsequent clicking will define additional vertices 
that will be connected in order to produce a curve.  
The user may left click and hold to draw out curves 
instead of clicking individual points.  When the region 
has been defined, right click to close the curve and 
create an ROI. 
 

• Composite: Multiple ROIs can be grouped into a 
single composite ROI by selecting them and clicking 
Group button in the ROI list window.  A composite 
ROI can subsequently be split into its component 
ROIs by clicking the Split button in the ROI list 
window. 

 

 

Intensity contour: Double clicking on the intensity contour tool will show the Contour options 
window.  Intensity contouring defines ROIs by identifying curves along which the image has a 
constant intensity level. 
 
• Level droplist: This control specifies whether the level for which contours will be created is 

explicit (specified by the user in the field at right) or obtained from the intensity at the point on 
which the user clicks to initiate contouring. 

• ROIs droplist: When the contour level is obtained from the point on which the user clicks, the user 
may choose to keep either all contours generated for this level (All), or only the contour that 
passes through the point that was clicked using this control (From cursor). 

• Allow droplist: The user may confine the region over which contouring will be performed by 
selecting an ROI from the Allow droplist.  When All is selected, contouring will be performed 
over the entire image slice or volume. 

• Slice buttons: Contouring can be performed on a range of slices based on the selection made in 
this control.  The user can choose to either contour only on the current slice, on all slices within 
the currently selected image, or over a range of slices as specified by the physical location of the 
slice. 
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Region grow: Double clicking on the region grow tool will show the Region grow options window.  
Region growing defines ROIs through selection of a starting point, and expansion of the region to 
include adjacent points that meet specified intensity criteria. 
 
• Grow droplist: Specifies whether the region to be grown should expand in two dimensions (ie, in 

the current slice only) or in three dimensions. 
• Threshold droplist: Specifies the type of intensity criterion to be used for region growing.  Choices 

are discrimination by either absolute intensities, by intensities relative to the starting intensity, by 
the intensity of the up image gradient, or by the intensity of the down image gradient. 

• Limits droplist: The user can select whether to discriminate points for region growing based on a 
lower limit, upper limit, or both. 

• Allow droplist: The user may confine the region over which regions are allowed to grow by 
selecting an ROI from the Allow droplist.  When All is selected, region growing will be permitted 
to continue over the entire image volume. 

• Search droplist: Instead of beginning region growing at the point on which the user clicks to 
initiate the process, one can alternately choose to search for a local minimum or maximum within 
the image.  If Minimum or Maximum is selected from this droplist, this search is performed and 
the starting location and intensity for region growing will be the location of the found minimum or 
maximum instead of the actual point that was clicked on. 

• Range field: When the Search option is selected, the value of this field determines the image range 
over which a local minimum or maximum will be identified. 

• Minimum, Maximum field: These fields specify the intensities that are the lower and upper limits 
of the region growing criteria.  When the Threshold selection is Absolute, the user may enter 
explicit values in these fields.  When Relative is selected in the Threshold droplist, these values 
will not be editable and will denote the limits determined from the image using the specified 
tolerance. 

• Tolerance field: When the Threshold selection is Relative, the Tolerance entered in this field 
denotes the range of intensities relative to the starting intensity that will be included for region 
growing.  For example, if the starting pixel intensity is 100 and the tolerance is set at 0.5, the 
lower intensity limit for region growing will be 50 and the upper limit will be 150. 

 

 

Gradient find: Double clicking on the gradient find tool will show the Gradient find options window.  
Gradient finding defines ROIs by initial performing region growing, then adjusting the contour 
vertices determined based on the gradient of the source image. 
 
• Find droplist: Specifies whether the region to be defined should expand in two dimensions (ie, in 

the current slice only) or in three dimensions. 
• Initial threshold options: Specifies the parameters of the region growing to be performed as an 

initial region definition.  The meaning of these values is identical to their meaning in region 
growing.  The ROIs created from this initial step can be kept if the Keep initial ROIs option is 
selected.  Otherwise, they will be deleted after the subsequent gradient adjustment has been 
performed. 

• Snap range:.This value specifies the range over which each contour vertex may be adjusted in 
order to shift it to a local maximum of the gradient. 

• Upsample field: Prior to vertex shifting, each contour determined in the initial step will be 
upsampled to a higher density of vertices.  The extent of upsampling is specified in this field 

• Downsample field: After vertex shifting, each contour will be downsampled to a lower vertex 
resolution according to the value of this field. 

• Smoothing field: After downsampling, the contour may be smoothed using a boxcar average over 
neighboring vertices by specifying the boxcar width in this field. 
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• Opening an ROI: ROI data can be loaded from an ROI file by clicking Open… under the ROI menu.  The user is then prompted 
to select an ROI file, specific to RT_Image, from which ROI data will be loaded. 

 
• Importing an ROI: ROI data can be imported from a DICOM RT structure set file by clicking Import… under the File menu. 

 

• Directory contents list: This list displays the contents of 
the currently selected directory.  The user can select a 
DICOM file from this list.  Once a DICOM file has been 
read, its contents are archived so that subsequent accesses 
of the file will not require a full re-scan. 

• Patient, date, and contour lists: Once a DICOM RT 
structure set file has been selected in the Directory 
contents list, the contents of the file are read and 
displayed in these fields.  The uneditable patient and date 
fields show information about the file, while the contours 
list shows the individual contours that are present in the 
file. 

• Load button: To load data, select the desired one or more 
CONTOURS from the contours list and click load.  
Note: selecting files from the directory contents list and 
clicking load will NOT open data.  

• Show DCM contents button: To view the DICOM tags 
contained in a given file, select the file from the 
Directory contents list and click the Show DCM contents 
button.  The window at bottom will then be displayed, 
showing a list of the tags present in the DICOM file, 
sorted by group and element number.  The list can be 
restricted to specific group and/or element numbers by 
filling in the appropriate fields at the bottom of the 
window. 
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• ROI representation 

 

Individual ROIs are represented as a planar, two 
dimensional closed curve with a fixed thickness.  They 
can therefore be considered slabs.  Shown at left is an 
irregular freehand ROI defined on an axial plane.  One can 
see on the coronal and sagittal views a cross section of this 
slab ROI by an image plane that is orthogonal to the 
surface normal of the closed ROI curve. 
 
Image views that are not coplanar with a given ROI will 
show the corresponding intersection of the ROI with the 
image plane.  When the view type is MIP, surface 
rendering, or volume rendering, the ROI will be projected 
onto the image plane rather than sliced.  These views are 
shown below for a composite ROI consisting of slabs 
defined on adjacent slices. 

 
 Slice view MIP view 
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• ROI management 

 

Once an ROI has been opened, imported, or created, and exists within RT_Image, the 
ROI list becomes visible. 
 
• ROI list: This list shows the currently open ROIs.  ROIs can be selected from this 

list. 
• ROI on/off button: The button on the left immediately below the ROI list controls 

whether the currently selected ROI or ROIs are drawn on the image. 
• ROI label field: The field to the right of the ROI on/off button sets the label for the 

selected ROI. 
• ROI display options: The color, thickness, and line style of the currently selected 

ROI can be manipulated using the controls below the ROI label field.  In addition, 
the user can choose to shade the contents of the currently selected ROI using the 
Shade button.  The transparency of the shading is controlled by the field to the right 
of the Shade button. 
 

• Region list: The individual regions of a composite ROI can be selected and edited 
using the droplist below the ROI display options.  The type of the currently selected 
region (freehand, ellipse, or rectangle) is shown in a label to the right of the droplist. 

• Region controls 
o Include/Exclude droplist: This option specifies whether the selected region 

defines image pixels that are or are not contained within the composite ROI.  By 
combining include and exclude regions, one can define donut-shaped composite 
ROIs. 

o Edit points button: Opens the Edit ROI window, which can be used to manipulate 
the vertices of the currently selected ROI region. 

o Geometry button: Opens the Geometry window, which can be used to manipulate 
the orientation of the currently selected ROI region slab. 

o Delete button: Deletes the currently selected ROI region. 
o Center fields: Define the center location of the region.  The user can enter values 

into these fields to translate the region. 
o Length fields: Provide the length in X, Y, and Z of the region.  The Z length is 

defined as the thickness of the region, and can be edited to create larger or 
smaller slabs.  For rectangles and ellipses, the X and Y lengths can also be edited 
to change the size of the region. 

• Group button: Groups the selected ROIs into a single composite ROI. 
• Split button: Splits the selected ROI or ROIs into their component individual, single 

region ROIs. 
• Statistics button: Opens the ROI statistics window, allowing analysis of the pixel 

statistics over the currently selected ROIs. 
• Reslice button: Reslices the selected ROI or ROIs according to the current view 

transformation.  For example, if an ROI consisting of a set of axial regions is being 
viewed coronally, clicking this button will cause the ROI to be reformatted so that it 
consists of a series of coronal regions. 

• Save button: Saves the currently selected ROIs to a ROI file, specific to RT_Image. 
• Export button: Saves the currently selectd ROIs into an existing DICOM RT 

structure set file. 
• Close button: Closes the selected ROIs and deletes all data associated with them. 
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• Editing ROI vertices: The vertices of a given ROI region can be manipulated by clicking the Edit points button in the ROI list 
window. 

 
 

 

• Image display window: When in Edit ROI mode, the 
select tool may be used to left click and drag ROI 
vertices to new locations.  Right clicking on an ROI 
vertex will delete it from the ROI.  The user may 
alternately right click and drag out a rectangle, which 
will delete any contained vertices when the right 
mouse button is released. 
 

Edit ROI window 
• ROI, Region droplists: The ROI and region to be 

edited can be selected using the droplists at the top of 
the window. 

• Resample options: The user may resample the selected 
ROI region to a new number of vertices using the first 
set of controls.  The user can enter the desired number 
of new vertices, the type of interpolation to be used, 
and whether the new samples should be spaced 
according to their original spacing or uniformally 
around the ROI curve. 

• Smooth options: The user may smooth the vertices of 
the selected ROI region using an average (boxcar) 
filter smoothing the specified number of adjacent 
vertices, or using a Fourier method in which the 
specified number of low-end frequencies are kept. 

• Snap options: Snapping allows the user to adjust the 
locations of the vertices of an ROI region to specified 
features of the underlying image.  The vertices can be 
adjusted over the specified range to search for local 
minima/maxima of the image intensity or gradient.  
The user can choose to apply this function to all 
vertices or only to those selected using the left mouse 
button with the select tool. 

• Morph options: The currently selected ROI region can 
be subjected to morphologic operators including 
dilation, erosion, opening, and closing, using the 
specified structuring element size. 
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• Editing ROI geometry: The orientation of the currently selected ROI region can be manipulated by clicking the Geometry button 
in the ROI list window. 

 

When an ROI is defined, its orientation is by default specified by the view.  The normal 
to the planar ROI curve and its in-plane directional axes is given by the normal and axes 
of the image view plane.  The user can edit this orientation using the Edit ROI geometry 
window.  
 
• Rotate options: These options allow the user to rotate the ROI region around the 

specified axis by the specified rotation angle, given in degrees. 
• Orientation buttons: The user can shift the ROI region orientation to preset types, 

including axial, coronal, and sagittal, using the buttons below the rotation options.  
Alternately, the user can reset the ROI region orientation to its original value by 
clicking the Reset button. 

• ROI geometry window: The user can manually adjust the orientation of the ROI 
coordinate system by left clicking and rotating the ROI axes within the preview 
window. 
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• Calculating ROI statistics: Parameters of the image pixel distribution encompassed by one or more ROIs can be calculated by 
clicking the Statistics button in the ROI list window. 

 

Upon clicking the Statistics button, 
the values for the currently selected 
ROI or ROIs are calculated over all 
open images.  They are then 
displayed in the text field of the 
ROI statistics window. 
 
• Update button: Recalculates all 

ROI statistics.  Because of the 
computational burden of 
performing these calculations, 
the user must click this button in 
order to recalculate whenever an 
ROI is moved or otherwise 
manipulated. 

• Customize… button: Opens the 
Customize statistics window, 
allowing specification of the 
statistics to be displayed and 
calculation options. 

• Compare… button: When 
statistics for two or more ROIs 
are displayed, the user may click 
the Compare button to show the 
Compare ROIs window, which 
allows consideration of ROI 
statistics over unions and 
intersections of two ROIs. 

• Export… button: Allows the 
user to save either the contents 
of the ROI statistics text field or 
the locations and intensities of 
all image voxels contained 
within the selected ROIs as a 
text file.  This allows export of 
the calculations performed 
within RT_Image to other 
spreadsheet or analysis 
software. 

 



©2003-2006, Edward Graves, Stanford University last updated November 14, 2006 

Page 24 of 24 

 

 

 

• Statistics options: Specifies the types of statistics to be displayed for the selected 
ROIs.  When percentile is selected, the percentile to be shown is given in the field 
beneath the Percentile button. 

• Field width field: Specifies the width in characters of each data field for the 
displayed statistics. 

• Decimal places field: Specifies the number of decimal places to be shown when 
displayed calculated statistics. 

• Sort ROIs droplist: Specifies how to order the ROIs when reporting statistics.  
ROIs can be ordered according to their order in the ROI list, sorted by name, or 
ordered based on the value of any of the statistics.  The selected order can be 
flipped by checking the Reverse button. 

• Ignore exclude ROI regions button: When selected, composite ROIs containing 
excluded regions will be considered without the exclude regions.  That is, statistics 
for the composite ROI will include any image pixels contained within exclude 
regions. 

• Show total line for selected ROIs button: When selected, an additional line in the 
ROI statistics display will be shown totalling the values for every ROI over each 
image. 

• Subanalysis options: The user can activate this option to compute statistics for 
subregions of the currently selected ROIs.  These subregions are defined by 
intensity: the user can choose to examine regions of the selected ROIs with 
intensities greater or less than a specified value.  When activated, the subregion 
analysis is displayed as an extra line beneath the statistics line for each ROI in the 
ROI statistics text field. 

 

 

• Compare ROIs: Using the controls in the Compare ROIs window, the user can 
construct a logical comparison of two ROIs.  This comparison is then used to 
select a combination of pixels comprising the two ROIs, and statistics for this 
hybrid pixel distribution is shown as an extra line in the ROI statistics text field. 
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